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IPod Tutorial
You finally took the plunge and bought yourself an iPod, (or better yet, somebody bought one for you.)
Are you wondering how on earth this tiny contraption can store so much music, so many podcasts, and
still have room for thousands of photos? Wait a minute, what’s a podcast? My iPod can hold photos?
OK, let’s slow down a bit. If you are new to the world of iPod and don’t know where to begin, this
tutorial should give you all the information you need to get started.
We’ll start with a glossary of basic terms:
iPod- The original, and the largest member of the iPod family, at 2.4 x 4.1 x
.43 inches. It weighs between 4.8 and 5.5 ounces, depending on whether it
holds 30 or 60 gigabytes(GB). Complete with a full color 2.5 inch screen,
this deluxe model plays movies, TV programs, and music videos, all of which
can be downloaded from the iTunes store. The 60 GB iPod stores up to
15,000 songs, 25,000 photos, or over 150 hours of video. It comes in black
or white. It is also available in a special U2 Edition.

iPod Nano-A smaller unit than the original, at 1.6 x 3.5 x .27 inches.
Apple compares it to the thickness of a pencil. It comes in a 1, 2, or 4 GB
size. A full color screen helps you manage your music, but it doesn’t play
videos. The 4 GB model holds up to 1,000 Songs or 25,000 photos. It
comes in black or white. Sorry, no U2 Edition Nano.

iPod Shuffle-The smallest, most economically-priced iPod. Dimensions are
3.3 x .98 x .33 inches, or about the size of a pack of gum. It comes in a 512
megabyte(MB) or 1 GB size. It doesn’t have a screen, but a slider control on
the back determines whether songs will be played either in a pre-determined
order or played at random. (This shuffle feature is also available on the iPod
and the iPod Nano). The 1 GB size holds up to 240 songs.
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iTunes-The music store created by Apple to sell MP3s, Audiobooks, Music Videos, and TV programs.
Free podcasts are also available to search and download through iTunes. Music is available for purchase
by the individual song or as the full album. Items purchased through iTunes are downloaded directly
onto your computer in electronic form. Through iTunes, music and other media are downloaded onto
your iPod.

MP3, WAV and WMA-These are file types for electronic media. While iPod is capable of running all
three types, MP3 files are recommended as the most compact. (This means you can fit more songs on
your iPod!) All songs downloaded from iTunes are in the MP3 format automatically.
Click Wheel-The controller on the iPod and iPod Nano, the click wheel
functions like the controls on a CD player, with a previous and next button, as
well as a play/pause button. Volume is controlled by rolling your finger over
the click wheel right or left. The click wheel can also be used to browse
through the various lists on your iPod. The white spot in the middle is the ON
button for the iPod and iPod Nano. Since there is no screen, the iPod Shuffle
does not have a click wheel.
USB Cable-This cable allows you to transfer media from your computer to
your iPod. This connection charges the iPod battery. One end plugs into
the USB port on your computer tower while the other end plugs into the
bottom of your iPod. To disconnect the USB cord, press in the buttons on
each side of the cable head.

Dock Connector Port-The rectangular hole in the bottom of your iPod where you connect your iPod to
the USB cable.
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Headphones Port- Located on the bottom of the iPod next to the dock connector port, this is where
you plug in your headphones.
Hold Switch-The button on the top of the iPod that allows
you to lock the iPod controls so that you don’t accidentally
bump it and interrupt whatever you are listening to. It also
prevents the screen on the iPod and the iPod Nano from constantly lighting up if the scroll bar is touched,
allowing you to save your battery charge.
Dock Adapter-A dock is a base to set your iPod in to recharge and sync. Apple sells a Universal Dock
that fits the largest iPod. A dock adapter is necessary to accommodate the smaller units. Basically, the
adapter is a small piece of plastic with holes that fit the Nano or Shuffle. While the Universal Dock with
adapter is not necessary to use your iPod, it allows you to hook your iPod up to speakers, to the TV, or to
use a remote control.
Sync-To connect your iPod with your computer to update new songs, videos, and information. iPod uses
auto-sync, meaning that each time you connect your iPod to your computer everything that has been
added since your last sync is updated to your iPod. It also works the other way. Any on-the-go playlists
you have created on the iPod will also be updated to your computer.
Upload-To transfer a file from your computer to another electronic device such as an iPod.
Download-To transfer a file from a remote computer or device to your computer.
Rip-To take songs from a music CD and convert them into MP3 files.
Burn-To copy music from iTunes to a CD.
Playlists-A list of songs you create on your iPod and in iTunes, pulling from your library of purchased
and ripped music. Using music playlists is the equivalent of using file folders for word-processed
documents.
Battery Life-The amount of time the battery on your iPod will last between charges.
Recharge-To bring the battery back to maximum power by hooking your iPod up to your computer. The
iPod and the iPod Nano have up to 14 hours of battery life before a recharge is needed. The Shuffle has
up to 12 hours.
Software Updates-Apple issues regular updates for iPod and iTunes. These updates offer advice for
improving functionality, correcting issues with previous software, or increasing battery efficiency. Check
periodically to see if there are updates for the iPod you own. Updates can be found on the Apple support
site, http://www.apple.com/ipod/download.
Podcast-A radio-type show that can be downloaded onto your iPod and played whenever it is convenient
for you. Generally, you subscribe to a podcast series (usually free) and get a new podcast from the
producer whenever one becomes available. Since they are rather simple to create and send over the
internet, and require minimal software, the quantity of podcasts is quite large. You can download free
podcasts through iTunes.
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Audio Book-Similar to books-on-tape recordings, only in the context of an iPod the book is in an
electronic file instead of a cassette or CD. This file can be downloaded to your iPod and listened to just
like music or a podcast. The iPod Nano allows you to even place a “bookmark” in your book where you
left off so you can start again in the same place when you turn on your iPod again.
Apple Stickers-Two white Apple logo stickers come with each iPod, for your sticking pleasure. Place
them anywhere you feel an Apple sticker will enhance your happiness. Don’t worry though, if you don’t
use them, your iPod will still work.
iPod Nano Mirror-I don’t know if Apple intended this, but you can use the back of your iPod Nano as a
mirror. Thanks, Apple, for thinking of those or us who want to look good while listening to our music.

*Please Note: For the rest of this article, I will be examining an iPod Nano. Most of the information that
applies to the Nano also applies to the standard iPod, or what I call the iPod Exp (short for expensive).
Since I am examining the Nano, I won’t cover playing videos. Maybe someday I’ll be rich and be able to
purchase an iPod Exp, then I’ll give a tutorial on that.
Included with your iPod Nano-The unit comes in a sleek black box that includes earbud headphones,
two sets of foam earbud covers, a USB 2.0 cable, a plastic dock adapter, a black felt case, a QuickStart
guide, a software CD, and of course the iPod nano.
Taking it out of the box-Remember to take a moment and enjoy opening the box. Note the smart
packaging, the smooth, clean lines and the nifty way the Nano is nestled in the cardboard. Before you
start banging the box against your desk to try and remove the Nano, observe the small, clear plastic tab
that allows you to easily pull it out of the box. If you don’t mind the words “Don’t Steal Music” in four
languages across your screen, you could always keep the plastic cellophane on the nano to use as a
protective cover…the click wheel works just fine through the plastic.
Installing the Software-The first step to getting your iPod up and running is installing the iTunes
software (included) on your computer. Be sure to do this before connecting your iPod. After
closing all other applications, insert the CD into the CD drive and follow the instructions given on your
screen. Apple has set defaults to simplify the installation, just fill out the necessary information (only
those fields with an * by them are required) and hit “next” at the bottom of each screen. You can also
install iTunes without the CD by going to www.itunes.com and click on download for the most recent
version of iTunes.
Setting Up your iPod-Once you have installed the software and restarted your computer, the next step
is to connect your iPod. Connect the USB cord to the bottom of your iPod. On the USB cord, the side
with the icon faces up. The other end of the cord attaches to one of the USB ports on your computer. If
you are unsure of what that is, just find an “outlet” on the back of your computer where the thing fits
and you’ll be on the right track.
Once you have connected, you will be asked on your screen to register the item. After doing this, hit
finish to automatically start the sync process and update any songs you may already have on iTunes to
your iPod. If your iTunes music library is empty, see Buying Music from iTunes or Uploading Music from
CD’s to iTunes.
You must set up the date, time, contacts, calendar, notes, screen lock and settings on your iPod. (See
below.) The stopwatch and games work automatically and do not require any set up.
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What Do These “Buttons” Do?-Maneuvering around your iPod can be a daunting task for new users.
If you are like me, you will try to use the click wheel as a back button. That doesn’t work. To go back,
you need to push the menu button. So how do you use the rest of the buttons?
White center button

.
Play/Pause button

Menu button

Acts as the ON button as well as the select or enter button when your iPod is
already on. Press this button after you have scrolled down to something that
you want to select. It is similar to clicking on something with your mouse.
This button also moves you forward through the setup screens
Plays and pauses media. There is no stop button on your iPod, so use this
button to stop a feature. This button also acts as the OFF button when you
hold it down for a few seconds.
Acts as the back button on your iPod. If you want to return to a previous
menu, the menu button will take you back through the previous screens. To
return to the main menu, continue pressing the menu button until you can’t
go back any further.

Next/Previous buttons Used to go forward or back to the next feature on the playlist. If you hold
them down, they fast-forward or reverse through whatever you are listening
to.
Click Wheel

Sliding your finger right or left across the round of your click wheel scrolls
through menus and controls the volume when something is playing. It is
functions in setting up the time, date, and screen lock, as well as moving you
from day to day on the calendar.

Setting Up the Basics on Your iPod- Date, Time, Contacts, Calendar, Notes, Screen Lock and
Settings
Setting the date and time
From the main menu, scroll your finger on the click wheel to Settings.
Press the white button in the middle of the click wheel; this will take you to the Settings
screen.
Scroll down to Date & Time and press the white button again.
First set your time zone, which should already be highlighted.
Press the white button and then scroll through the list to find your time zone.
Once you choose your time zone, it will automatically reutrn to the previous menu.
Now scroll down and choose Set Date & Time.
This will bring you to the Date & Time screen.
To change the time, press the white center button until the blue indicator is on the
number you want to change.
Using the click wheel, scroll right or left to increase of decrease the number.
When you are finished with one section, press the white button to go on to the next
item.
When everything is correct, press the menu button to leave this screen.
Do you want your time displayed in 12 hour or 24 hour time (military time)? Pressing
the white button while on the Time display will change this.
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Do you want the time to be in the title of your iPod (up where it now says Date & Time)?
If so, scroll to the Time in Title option and press the white button until it says On.
You have esuccessfully set up the date and time. Click the menu button twice to go back
to the main menu. For more information on using the time feature on your iPod,
including how to set alarms and world clocks, see Setting Alarms, World Clocks and Using
the Sleep Function.
Viewing and updating the calendar
Choose Extras from the main menu, then scroll down and choose Calendar.
The All option will display the calendar of the current month.
To go to the next month, press the  button. To go back, press the  button. To go
to a certain calendar day, scroll to that day and then press the white button.
You cannot add items to your calendar directly on your iPod; instead update your
calendar on your PC and then sync it with your iPod. See Updating the Calendar, Notes
and Contacts on your iPod for more details.
Viewing and updating notes
Choose Extras from the main menu, then scroll down and choose Notes.
Scroll down to the note that you want to view and press the white button.
If you haven’t added notes to your iPod yet, you will see the instructions note.
For details on how to add notes to your iPod see Updating the Calendar, Notes and

Contacts on your iPod.
Viewing and updating contacts
Choose Extras from the main menu, then scroll down and choose Contacts. Scroll down
to the contact that you want to view and press the white button.
Unless you have added contacts to your iPod already, you should only see the
instructions option and the sample contact.
For details on how to add notes to your iPod see Updating the Calendar, Notes and

Contacts on your iPod.
Updating and using the Screen Lock
The screen lock feature allows you to lock your iPod so that others cannot access it.
Choose Extras from the main menu, then scroll down and choose Screen Lock.
If this is the first time using the screen lock you will first need to set combination.
Select this option by pressing the white button.
This screen looks like a combination lock and asks you to choose the combination.
Scroll right or left on the click wheel to increase or decrease the numbers then click the
white button to move to the next field.
Once you have updated all the fields with numbers, press the white button again to leave
the screen.
Now the option Turn Screen Lock On should show up on the screen. Select this option
and then choose Lock from the next screen. The lock will be displayed whenever you
pull up the screen. You will need to enter the code to open it.

7

FeedForAll Feed Creation Software
http://www.feedforall.com
RecordForAll Audio Recording Software
http://www.recordforall.com

Repeat the steps each next time you want to activate the lock. You don’t have to choose
a new code each time. If you enter the wrong code, the numbers will flash and you can
try again. If you totally forget your code, connect to your computer to unlock your iPod.
Using Your Stopwatch
The stopwatch is a useful feature, especially if you use your iPod while exercising.
Go to the Extras menu and scroll down to Stopwatch.
Click on Timer; this will bring the stopwatch screen up.
The larger top set of numbers on the stopwatch shows the total time of the session.
The smaller second set of numbers shows the current lap time. This way you can time each lap
while keeping the total time.
Use the Play/pause button to start, pause, and resume timing.
The button on the right keeps lap times if time is running, but clears the time if it has been
paused.
To start the total time and the current lap, scroll to the Start button and press the white center
button to start timing.
If at this point you scroll over to the lap button, the current lap time will be recorded in the
sessions log, and a new lap time will start. The total time appear to have stopped timing
momentarily, but after 5 seconds it will pick up again.
Select Pause to stop both timers. Select Resume to restart them.
Select the Done button to end the session. Final times will be recorded automatically in the
session log.
To reset the display, return to the stopwatch by choosing Timer from the menu and then
pressing the Clear button.
To listen to music while using the stopwatch use the play, next  and previous  buttons.
These icons will also be displayed in the top left corner of your iPod screen while using the
stopwatch.
You may use the menu button and the click wheel to visit other screens while using the
stopwatch and it will continue to mark time.
The stopwatch will automatically stop for three reasons: the time counter reaches 24 hours, the
iPod goes into hibernation (this only happens after your iPod hasn’t been used for 14 hours), or
you connect your iPod to a computer. Turning your iPod off or putting it to sleep by pressing the
play/pause  will not stop the stopwatch.
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Stopwatch Sessions and Session Logs
Each time you select Done on the stopwatch, it saves and closes the current session. It is saved
in a session log. iPod can store up to five session logs, deleting the oldest session when the sixth
session is added.
All session logs include:
Date of the session
Time of day the session was run
Total time of the session
Shortest and longest lap times
Average of all laps
A list of each individual lap time (up to a maximum of 200 laps for iPod 1.1 software and
later)
To view a session log, select the session from the Stopwatch menu.
Scroll down to see the whole session (the individual laps are at the bottom of the screen).
To delete a session, press the white center button while viewing a session and then press Delete.
Alarms on Your iPod
Alarms are useful to remind you when you need to do something or to let you know your 30
minutes of exercise is finished. The alarm can be heard whether or not you have your earphones
on; however, it isn’t very loud and it beeps only once. You may set multiple alarms since each
clock has its own alarm.
To set your alarm:
From the main menu select Extras
Select Clock and highlight a clock on the list
Select Alarm Clock
Press the white center button while Alarm is highlighted to turn the alarm on
The screen should say Alarm On
Press the white center button while the Time option is highlighted to set the alarm
Using the click wheel and the white center button, adjust the time
Select Sound from the alarm menu and choose either Beep or one of your playlists. Note that
alarms set with music can only be heard through the earphones.
Unless you deactivate the alarm, it will continue to sound at the same time each day.
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Setting the Sleep Timer:
If you like falling asleep to music, you may want to use sleep timer. This function allows you to
play music for a period of time. The Nano will turn off automatically when the time interval has
passed.
Select Extras from the main menu
Select Clock and highlight one of the clocks
Select Sleep Timer
Use the click wheel to scroll over the time intervals. There are 15, 30, 60, 90 and 120 minute
intervals. Press the white center button to select an interval.
The timer will immediately begin counting down
The iPod will continue to function normally and will turn itself off at the end of the interval
Adding Clocks on iPod Nano or Fifth Generation iPods:
For newer iPods, you have the option of setting multiple clocks. You can set clocks for different
times around the world or set several clocks for your current location so that you can then set
several alarms.
Select Extras from the main menu
Select Clock
Scroll to new clock and press the white center button
Choose an area of the world and press the white center button again
Select the city; iPod automatically adjusts the time for that city
Increasing the Life of your Battery:
The battery life of an iPod varies from unit to unit. The iPod Nano has up to 14 hours of music
playtime and up to 4 hours of photo slideshow with music viewing time when fully charged.
There are ways, however, to increase your battery life from charge to charge.
1.
2.

3.
4.
5.
6.
7.
8.

Keep your iPod updated with the latest version of iPod software.
Switch the unit to Hold whenever you are not using your iPod. To do this move the Hold
switch to the Hold position. This prevents the unit from waking up from sleep or playing
songs if buttons are pressed accidentally. You can still listen to music; the hold setting
just prevents the screen from lighting up every time you touch anything.
Keep your iPod at room temperature. Avoid extremes in temperatures. Do not leave it
in a vehicle or exposed to direct sunlight.
Charge your iPod as soon as the battery runs down, even if it won’t be used right away.
Press the play/pause button to pause playing when you are not listening.
Turn off backlighting if you don’t need to use it. Select Settings, Backlight Timer, and Off
Avoid changing songs by pressing the forward or previous button.
Use compressed song formats such as MP3 or AAC instead of AIFF formats.
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Using Your iPod to Play Music
Putting Music on Your iPod
Music can be added to your iTunes library in two ways:
1.

Uploading CD’s that you currently have in your music collection. (See Uploading
Music from CD’s to iTunes for more details on how to do this.)

2.

Buying songs from iTunes. (See Buying Music from iTunes for more details on
how to do this.)

3.

If you have already downloaded music on your computer using a program other
than iTunes, it must be unprotected to import. One way around this is to burn
these songs onto a CD and then rip them back onto your computer using iTunes.
(See Buying Music from other Music Stores for more details on this.)

Uploading Music from CD’s to iTunes
Insert the CD into the CD drive on your computer.
Wait a few seconds for iTunes to recognize it. The title will appear with a small CD icon next to it
in the Source menu.

Click on the CD name to bring you up a list of all the songs on the CD.
Uncheck the boxes in front of the songs you don’t want to upload. (The boxes will
automatically be checked.)
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You are ready to import your CD. Click the Import CD button in the top right hand corner of
iTunes.

An orange icon will appear next to the song that is currently being uploaded.

Once uploaded, all music will be added automatically to your music library and will load to your
iPod the next time you plug it in.
Purchasing Media from iTunes
iTunes has expanded with the popularity of iPod. In less than two years iTunes has sold 200
million songs. iTunes also offers iPod listeners free access to podcasts and, more recently, to
television programs. In order to use your iPod you must download the latest version of iTunes.
To purchase items on iTunes, you must set up an account and give iTunes your credit card
information.
Search for music using the Search or Browse functions under the categories of music.
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Once you have located a song that you would like to purchase, click the Buy Song
button next to it.

This will open a dialog box that allows you to Create New Account.

Read through the Terms of Service and press Agree if you agree to them.

Enter the necessary information on the next screen. If you don’t want to receive emails
from iTunes, uncheck the boxes toward the bottom of the screen.

Press continue.
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Enter your credit card information and billing address (the one you have your credit card
billed to).
Hit Done and you are all ready to go.

Each time you press Buy Song from now on, iTunes will automatically bill your credit
card. Orders are processed on a daily basis, so if you purchase six songs in one day,
that will show up as one charge for $5.94. You will also receive an email from iTunes
that includes all the purchases you made that day.

Each time you purchase a new song, a dialog box will appear asking you if you’re sure
you want to buy and purchase the song. While this box may seem like a hassle each
time, it has saved me a few stray purchases when I pressed the wrong BUY SONG
button, so think twice about checking the “Don’t ask me about buying Songs again” box.
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Once the songs are on iTunes they will automatically load on your unit the next time you
plug it in. To have more control over what loads to your iPod, see Updating Your iPod
Manually.

To listen to your music:
Select Music from the main menu
You can categorize your music by playlist, artist, album, song, podcast, genres, or composers.
(To prolong the life of your battery use playlists. This helps to avoid skipping songs and overusing the backlight to choose songs.)
Chose a song and press the white center button. The title will appear on your screen
Press the play/pause button (Remember to plug in your earphones)
To adjust the volume, move your finger across the click wheel while the song is playing
To pause or stop music, press the play/pause button
Turn the iPod off by holding down the play/pause button

Updating Your iPod Manually
If you have an extensive iTunes library or your family shares an iTunes account, you may want to
update your iPod manually.
Connect your iPod to the computer.
Select the Edit menu and choose Preferences. (Pressing the Ctrl key at the same time as the
comma key on your keyboard will automatically pull up the preference menu.)
Scroll to the iPod tab and then the Music tab.
You can disable automatic updates in two ways. The first is easier, but gives you less control.
Choose Automatically update selected playlists only and then check the playlists you want
updated each time from the menu.
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By choosing this setting, only those playlists which you have selected will be automatically
updated on your iPod. If you add a playlist that you want to have automatically updated, check
that playlist in preferences.
The second way to disable automatic updates is to Manually manage songs and playlists.

The following pop-up box will appear on your screen:

To manually eject your iPod, select Eject from the menu.
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To update your iPod manually, you must scroll through and choose each individual song you
want to have added to your iPod.
***If you choose this setting and someone else uses iTunes on your computer, make sure to set
it back to manual before connecting your iPod or all updates will be overridden.***
To add songs manually to your iPod:
Hook up your iPod to your computer
The iPod icon will appear under the Source section of iTunes
Highlight the Library folder at the top of your Source list and select the songs you want to add to
your iPod
While holding down your left mouse button, drag the song over the top of your iPod icon Drop
the song by letting go of your mouse button.

You can drag several songs at once by holding down your Ctrl key while choosing songs (this
allows you to highlight several songs at once).
Click anywhere in the highlighted area and drag the songs over to your iPod.
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To add several songs in a row to your iPod, use the Shift key. Click on the first song in the list
and scroll down to the bottom of the list
While holding down the shift key, click the last song you want added. This will highlight all the
songs in between as well.
Click anywhere in the highlighted area and drag it to your iPod.

Creating and Using Playlists
A playlist is similar to folder. It allows you to group together types of music, mixes, or any combination
of songs. Let’s say you have a certain mix of music you like when you exercise. You can create a playlist
called Exercise and add songs that get you moving.
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To create a playlist, click on the Create a Playlist button at the bottom left side of iTunes. (It looks like a
plus sign
.) Or you can choose New Playlist from the top of the File menu. This will give you a
blank playlist in your Source menu.

Type in the name of the new playlist and press enter. iTunes automatically alphabetizes your playlists for
you. To change the name of your playlist, double click on it and type in the new name.
To add songs to your playlist, click and drag the titles over the playlist and drop them in. You can drag
more than one song at a time using the Ctrl key or the Shift key as was demonstrated in Updating Your
Music Manually.
The playlist will automatically update on your iPod the next time you hook it up to the computer (unless
you chose to update your iPod manually). The new playlist will automatically show up on your iPod when
you choose playlists from the Music menu.
To listen, select the playlist and press play. It will now only play the songs in this playlist. If you want to
have the playlist repeat over and over, choose Repeat from the Settings menu and update it to All.

Storing Photos on Your iPod
One of the benefits of owning a Nano instead of the Shuffle is the capability to store and view photos. If
you are using a PC, create a new iPod photo folder on your desktop to store all the photos you plan to
update to your iPod.
To create this folder, right click on the Start button and select Explore. From the File menu select New,
and then select Folder. A new folder will be created.

Type in the name of the new folder, for example iPod Photos, and press Enter. You may now add photos
you have already stored on your computer. Click and drag photos from their present folders to the new
folder; or, if you want to keep them in the original folder as well, you may copy and paste them.
Once you have added all the photos to your iPod folder, return into iTunes and right click on the iPod
icon. Select iPod Options from the drop down menu.
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From the Options menu select iPod Tab and then Photos Tab. Check Synchronize photos from and select
Choose Folder from the dropdown menu. Highlight your new folder and click OK. Photos will be
automatically formatted and updated to your iPod.

Viewing Photos on your iPod
From the main menu, scroll down to Photos and click on the white center button
Scroll down to Photo Library and click the white center button. This will bring up thumbnails of all stored
photos
Scroll through thumbnails, selecting those you want to view by pressing the white center button, or you
may use your next and previous buttons to view every photo.
To View a Slideshow
From the Photos menu select Slideshow Options
Manually set up each option and press the menu button to return to the previous screen
Scroll to Photo Library and press play. Your slideshow will begin immediately
You can pause a slideshow the same way you pause your music
The screen will remain on the last photo until you choose Repeat under Slideshow Options
**Note that the backlight timer will be ineffective while viewing slideshows. Remember to close the
slideshow by pressing the menu button, or it will continue to play and will run down your battery very
quickly.
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Downloading Podcasts
iTunes has made it easy to download, listen to, and organize podcasts.
From the Music Store, search or browse Podcasts
Click Get Episode to download podcasts you want

To subscribe to a series of podcasts, click the Subscribe button located in the Podcasts information page

iTunes will automatically download the most recent episode and all future episodes of that podcast until
you turn off your subscription.
Unless you like sorting through loads of podcasts, hold off on subscribing to numerous episodes until you
learn how to manage podcasts bettter. See Managing Your Podcasts for more information.
Listening to Podcasts
To access your podcasts select Music from the main menu, and choose Podcasts
Click the podcast you want and press play
You can pause the podcast at any time
Managing Your Podcasts
Users generally subscribe to a series, not to just one individual podcast. For this reason, they can rapidly
clutter your computer. To keep podcasts in check, there are a few tools iTunes provides.
Right click on the Source menu and choose iPod Options
From the options screen, choose the iPod Tab (it should already be on this), and select Podcasts If you
want to automatically update all podcasts each time you hook up your iPod, leave settings on

Automatically Update all Podcasts
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To have more control over what gets updated, click Automatically Update Selected Podcasts Only. A list
of the podcasts you are subscribed to will appear
Check the podcasts you want to update automatically

You can further refine the auto update options by the following options from the dropdown box on the
bottom of the options screen: All Episodes, Only Checked Episodes, Only Most Recent Episode, or Only

Unplayed Episodes

If you prefer to manage your podcasts manually via the drag and drop method, choose Manually manage

Podcasts. This requires you to drag an drop every episode you want on your iPod.

iPod Games
Your iPod comes with four basic games: Brick, Music Quiz, Parachute and of course Solitaire. iPod has
recently introduced a more games that you can purchase through iTunes. To purchase games go to the
iTunes store and click on iPod Games. You can buy them as a pack or individually.
Buying Music from other Music Stores
Before purchasing my iPod I used to shop around for the best deals on various internet music stores.
This was a great way to build my CD collection, but it poses a problem now because outside files are not
compatible with iTunes and cannot be downloaded to the iPod. Fortunately, I have figured out a way
around this. It is a bit of a hassle, so the deal has to be exceptional. This tip is useful if iTunes doesn’t
have the song you are looking for but another site does.
One internet music store I frequent is Walmart Music. If you try to import the music from Walmart Music
to iTunes, it will look like it is going to work at first, but then you get a pop-up box that says the songs
are in a WMA format and iTunes needs to convert it. Unfortunately, iTunes can’t convert protected WMA
files.
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The solution is to burn your WMA files onto a CD and then rip them back into iTunes. (I used Nero
software to do this, but any software for burning CDs should work.) The ripped songs show up on
iTunes as Track 01, Track 02, etc. To enter track titles, right click on the track and select Get Info. Click
on the Info tab and update the title and track information. Voila! You have imported WMA files into
iTunes! Of course, I’m sure that once iTunes finds this out they will find some way to prevent this…
AudioBooks and your iPod
Audiobooks can be purchased from iTunes or other audiobook stores such as Audible.com or
audiobooks.com. (Both of these sites download files compatible for listening on iPods; however, be
aware that not all audio bookstores are as convenient.)
To place an audiobook on your iPod from iTunes, simply purchase the book and it will update
automatically the next time you plug in your iPod. (If you update manually you must click and drag each
book onto your iPod.) Note that there is a separate category for audiobooks in the iPod menu. From the
main menu choose Music and scroll down to Audiobooks. A list of your purchased books will appear.
Select a book and start listening. Press pause to end your session. At your next session your iPod will
start you at the place you left off.
You can adjust the speed at which your audiobook plays. Go to Settings, and then Audiobooks. You may
choose between Slower, Normal or Faster.
Caring for Your iPod
To extend the life of your battery and keep your iPod in good working condition follow the instructions
given in Increasing the Life of Your Battery. Use common sense in handling your unit. Do not drop or
toss it at hard objects, or step on it. iPods operate best if kept at room temperature, although they
function normally at temperatures between 32°F to 95°F. If your unit has been left out in the cold, give
it a chance to warm up before turning it on. Never leave your iPod in a hot car or in direct sunlight, as
high temperatures can cause irreversable damage.
Keeping Your iPod Up to Date
Apple provides regular updates for your iPod, making new features available or improving current
features. In order to keep your iPod up-to-date, download the iPod Updater from the Apple website at:
http://www.apple.com/ipod/download/
This software gives you the option to restore your iPod to your original condition. Be aware, however,
that this function deletes everything from your iPod, so make sure you have backed up all music,
podcasts, audiobooks and photos you wish to save.
Once you have downloaded the iPod Updater software, you can then run it to update your iPod to the
most recent version. When the software has updated your iPod, you are all set and should be good to
go.
To check what version of software your iPod currently has, go to the Settings menu from the main menu
and then click on About. This gives you the version you currently have. I only purchased my iPod a few
months ago and my version was already out of date, so it is good to use the iPod Updater on a regular
basis.
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Troubleshooting
Now that your iPod is up and running, you will never have another problem, right? Not always…judging
from the extensive support section on the Apple website, it is clear that there are times when iPod
doesn’t work exactly as hoped for. I advise you to search the web or visit the Apple Support Page for
troubleshooting articles.
One problem I ran into is that the iPod screen continued flashing Do Not Disconnect after iTunes had
finished its update. If you choose to update your iPod manually, it doesn’t automatically eject itself when
the update is finished. You must manually eject or you will continue to get the Do Not Disconnect
screen. To disconnect, go into iTunes and right click on iPod and select Eject . Your screen should
return to normal again.

Most problems that you have with your iPod can be solved by following the five R’s:
Reset
Retry
Restart
Reinstall
Restore

**The last option should only be done if you have tried everything else, and you have backed
up all your music, photos, podcasts and audiobooks. Once you Restore, all files will be
erased from your iPod and you will have to start again updating its content.
Updating the Calendar, Notes and Contacts on your iPod
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The extra features on the iPod are useful if you regularly use Microsoft Outlook or Outlook Express. You
can update your calendar, notes and contacts from Outlook or Outlook Express to your iPod each time
you hook it up. (I have heard that Palm Desktop software also works with your iPod, but since I don’t
use a Palm, I can’t give any details on this. I imagine that any software that is compatible with the iPod
will show up in the drop down box in the preferences screen when setting up your iPod contacts or
calendar.)
Updating Contacts
You can choose to have all of your contacts update manually or select only certain groups to update each
time you sync. For details on how to view your contacts once you have updated them, see Viewing and
Updating contacts.
To update contacts from Outlook or Outlook Express, plug your iPod into your computer
Choose Preferences from the File menu
Click on the iPod tab and then click on the Contacts tab
Check the box that says Synchronize contacts from
Select Outlook or Outlook Express from the drop down box
Click Apply
If you are using Outlook Express, this is all you have to do. If you are using Outlook, there are a few
more steps to take.
For Outlook users:
A dialog box will appear letting you know that a program (iTunes) is trying to access data from Outlook
Put a check in the Allow access for box and then choose a time limit from the menu
Click Yes to close the dialog box
Click OK to close iTunes preferences and start the sync process
You will need to update this dialog box each time you plug in your iPod
Updating the Notes
Updating the notes on the iPod can only be done through your computer, you cannot enter a note
through your iPod. To enter a note:
Type your note or information into whatever word processing program you prefer, Word, WordPerfect,
WordPad, etc.
Save it as a .txt file in whatever folder you choose
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With iTunes open, use Windows Explorer (Right click on the start menu and chose Explore) to find your
document and then click and drag that file over top of the iPod icon in iTunes.
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Updating the Calendar
To have your Outlook calendar update to your iPod each time you hook it up:
Open iTunes and connect your iPod
Choose preferences from the file menu
Click the Contacts tab
Select the “Synchronize calendars from Microsoft Outlook” box
Click apply
A dialog box will appear letting you know that a program (iTunes) is trying to access data from Outlook
Put a check in the Allow access for box and then choose a time limit from the menu
Click Yes to close the dialog box
Click OK to close iTunes preferences and start the sync process
You will need to update this dialog box each time you plug in your iPod

This iPod tutorial was produced by FeedForAll if you require software for creating iTunes compatible
podcasts, podcasts or RSS feeds. Consider FeedForAll and RecordForAll http://www.feedforall.com and
http://www.recordforall.com
Additional tutorials are available on the above websites.
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